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Pro-Stitcher - Art and Stitch Basics 
 

I. Set Up to Begin Working 
A. You may also want to select a Palette of thread colors at the bottom of the page 

1. A bar of color chips extends across the bottom of the page 

2. The color chips in this bar represent the colors in your selected thread palette. 

3. Left click on the Choose Embroidery Thread Chart icon  at the left end of the bar 
and you will find a list of 21 different thread companies.  

a) Select the brand of thread you prefer to use, and the color chips will display the 
colors of your preferred thread brand. 

B. Select the measurement system you would prefer to use 

1. A ruler runs along the top and down the left side of the design page. 

a) Right click on the ruler and you will be able to select Metric or English  

(1) Select Metric if you prefer the measurements in millimeters. 

(2) Select English for measurements in inches. 

C. Select a Background Color for the design page 

1. You can easily change the background color of your design page. 

2. Open the View menu 

a) Scroll down and select Background 

b) You will be offered a choice between Fabric and 
Color 

3. If you select Fabric a folder of scanned fabric swatches 
opens and you can select a fabric image to use on the 
design page. 

a) Select the fabric you want to use and click OK.  

b) You can scan your own fabric swatches and use them as a design background 

(1) You do not need a large piece of fabric to scan.  A piece that is 3 or 4 
inches will be sufficient. 

(2) Save your scans to the C:/Program Files/Artistitch/Art and Stitch/Fabric 

4. If you select Color and the Color box opens. 

a) Select a color from the palette of Basic colors on the left. 
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b) Or select a color from the prism on the right and click Add to Custom Colors.   

(1) Move the black hash mark around on the large square prism and the 
selected color is shown in the box below the prism. 

c) Once you have found the color you want, use the column on the right to make 
your color lighter or darker. 

(1) Move the arrow down for a darker shade 

(2) Move the arrow up for a lighter shade. 

d) Click Add to Custom Colors 

(1) Your new color will be added to the Custom colors on the right.  

(2) You can then select it and click OK 

e) The color you selected will be applied to your design page 

D. These changes will remain selected until you choose to change them.   

1. Even if the program is closed your choices remain unchanged. 

2. When you open the program next time, your selected thread, measurement system, 
and background will be just as you left them. 

 

II. What is Art and Stitch 
A. The Art and Stitch program that was included with your Pro-Stitcher is a digitizing program 

1. That means it is a program designed to take a computer picture and turn it into a stich 
file that can be sewn. 

a) You can create quilting patterns for your Pro-Stitcher 

b) Or you can create embroidery or quilting patterns to be stitched with your 
embroidery machine 

B. This class will explore some of the ways that you can create your own custom quilting 
patterns 

 

III. Apply Run Stitches to a Vector Image 

A. Left click on Import Vector Art  

1. Select your clipart file (Vector Art files would be .WMF, 
.EMF, or .AI files) 

2. Double click on the Magnifying Glass  to Zoom to Fit. 

3. Left click on Running Stitch  

4. And just that quickly you have a quilting pattern  

B. However he is not really an ideal quilting pattern 

1. There were three colors in the design 

a) The grey of the elephant 

b) His white tusks  

c) And the black outline 

C. Run the Sewing Simulator to see how it will quilt 

1. The Draw Bar and the Sewing Simulator are at the bottom of the page above the 
thread palette 

2. Drag the cursor on the draw bar, or left click on the Simulator arrow that points to the 
right to see how the design will sew. 
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3. A running stitch has been placed around all three colors in the picture, so there are 
white stitches around the tusks, grey stitches around the grey of the elephant, and black 
stitches on all of the black outlines. 

 

IV. Edit the Vector Art and Then Apply Run Stitch 

A. It I easy to use the layered effect of Vector art files (Vector Art files would be .WMF, .EMF, or 
.AI files) to eliminate everything that we do not want to stitch. 

1. Open a New  design page 

B. Left click on Import Vector Art  

1. Select your clipart file (Vector Art files would be .WMF, .EMF, or .AI files) 

2. Double click on the Magnifying Glass  to Zoom to Fit. 

C. Use Color Sort to organize the colors in the elephant 

1. Select the Sequence View tab on the right side of the page 

2. Left click on All Items at the top of the Sequence View 

3. Left click on Color Sort  on the top toolbar 

a) The pieces of artwork are grouped according to color 

b) The elephant does not look so good, but he will be fine once we have deleted 
the colors we do not want to trace. 

D. Delete the colors that will not be traced 

1. Left click on the gray in the Sequence View and touch Delete on the keyboard 

a) Progress!  

2. Left click on the white in the Sequence View  

a) That is the first color that you cannot really see because the white tusks are 
the same color as the white page they are sitting on 

3. Touch Delete on the keyboard 

a) And now all that is left is the black outline 

b) Perfect 

E. Select All Items at the top of the Sequence View and left click on Running Stitch  

1. And we have elephant, but there are a lot of jumps represented by the dotted lines.   

a) This is still not the ideal quilting design but we are close. 

b) With a little simple editing we will have a  good quilting design 
 

V. Edit the Elephant for the Best Stitching 
A. There are just three lines here that do not touch any other 
line. 

1. The three lines that do not touch are the detail 
lines on each ear, and the eye. 

a) Hold down the Control key on the keyboard 
and select all three lines 

b) Change the color of these three lines to red 
by left clicking on a red color chip in the Color 
Palette at the bottom of the page.  

(1) This will help us keep these lines 
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separate while we make the rest of the lines sew as one continuous line. 

B. Select All Items at the top of the Sequence View 

1. Left click on Color Sort  

a) And the lines in the elephant have been sorted by color, so all of the black 
lines are together and the three red lines are together. 

C. In the Sequence View, select the black elephant at the top 

1. This selects all of the black lines that are in the 
elephant 

D. Right click and select Merge from the pop up menu 

1. The only jumps shown by dotted lines are now 
those between the three red lines! 

E. And now we can change all of the lines in our elephant to 
the same color 

1. Select All Items at the top of the Sequence View 

a) Find the grey color you want for your 
elephant in the color palette and click on that 
color chip. 

b) Now the elephant will be sewn all in one color.  

2. Left click on 3D  to see how the elephant will look when it is sewn  

 

VI. Reshape Tool 

A. Use the Reshape Tool  to fine tune the lines of any design 

B. Select the outline of the elephant in the Sequence View. 

C. Left click on the Reshape Tool  

1. And the outline of the elephant changes to a pink outline  

2. There is a Red dot – This is the ending point of the stitching line 

3. There is also a Green dot – This is the starting point of the stitching line 

a) If the Green dot is not visible, it will be under the red dot. 

b) This just means that the stitching starts and ends in the same place. 

c) To change the start or end point, simply click and drag the dot to the desired 
spot and right click on the design page to apply the change 

4. There are also small blue squares along the stitching line and they control the shape 
of the line 

D. The small blue squares around the edge of the elephant are called Bezier points, and they 
control the shape of the elephant. 

1. The change the shape, click and drag the Bezier points and right click in the 
background of the design page. 

2. To add more Bezier points to the line, right click on the line at the spot where you want 
to add a point and select Add point from the pop up menu.   

a) Adding points will allow you to bend or adjust the line in more places. 

3. When you left click on a Bezier point you may see whiskers that shoot out from the 
center point.   

a) Moving the whiskers will change the shape of the curve  

b) Click and drag to make the whisker longer and the line curves more 
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c) Click and drag to make the whisker shorter and the line curves less 

4. Right click on a blue Bezier point to change what type of point it is. 

a) Line points will create straight lines and pointy corners 

b) Cusp points are used at a place where the line changes. For instance, it could 
be straight on one side and curved on the other.  

c) Smooth points create curves 

d) Symmetrical points create curves that are the same on both sides of the center 
point. 

E. Use the Bezier points to edit lines in your design that are not stitching as you want them to. 

1. Manipulate the blue Bezier points to change the shape of the pink line 

2. Then right click in the background of the design page  

3. And the stitches will shift to match the shape of the pink line. 

 

VII. Use the Reshape Tool to Fix the Elephant 
A. To fix the elephant trunk 

1. Click and drag the Bezier point at the top of the elephant trunk to move it to the left 
side of the tusk. 

2. Click and drag the whisker control down to flatten the curve slightly 

3. Right click on the background area of the design page. 

 

VIII. Saving Your Design 

A. To save the design 

1. Open the File menu and scroll down to Save As 

2. Formats for those who want to sell the designs they create 

3. The Save As box opens 

a) In the Save in: window select the folder where the design is to be stored 

b) In the File name: window give the design a name 

c) Save the .ans editing file. 

(1) The .ans file should always be saved first. 

(2) This file can be re-edited at a later date in the same ways you edited on 
the day you created the design. 

4. You will also need to save the .hqf 
file that the Pro-Stitcher reads 

a) Open the File menu and 
scroll down to Save As 

b) In the Save in: window 
select your flash drive 

c) The name you selected 
will already be in the File 
name: window so no change 
is required there 

5. Open the Save as type: window  

a) You can save in a variety 
of quilting formats 

b) Or you can save in any 
one of the many embroidery 
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formats 

c) There is also an option to save in All Embroidery Formats or All Quilting 

d) Select HQ Pro-Stitcher (HQF) and Save 

B. The flash drive can then be inserted in the Pro-Stitcher  

1. Go to the Library 

2. Touch Load Pattern 

3. Navigate to the flash drive  

4. Select your design and quilt 

 

IX. Drawing Tools 
A. The five different drawing tools can be used to trace a backdrop image, or if you are good at 
drawing you can use them to draw your own pictures on an empty design page! 

1. Left click on New  to open a new design page 

B. To use the five drawing tools: 

1. Pen  Left click and drag to draw with the Pen tool.  

a)  You will see a line along the path you have traced. 

b) When the left mouse button is released, Bezier points will appear along the 
path you have traced. 

c) Right Click to finish the shape. 

1. Line   A Bezier point will be placed by each left click 

b) Hold the Control key to create curved lines. 

c) Release the Control key to create straight lines. 

d) Use the Backspace key to remove any points that you want to redo. 

e) Right Click to finish the shape. 

4. Curve  A Bezier point will be placed by each left click 

c) Curves are created in the same way as they are with the Line tool except that 
you do not need to hold down the Control key on the keyboard. 

d) Use the Backspace key to remove any points that you want to redo. 

e) Right Click to finish the shape. 

1. Bezier  A Bezier point will be placed by each left click  

a) To create curved lines, left click to place the point, hold the mouse button down 
and drag the mouse to adjust the curve of the line. 

b) To create straight lines, just left click to place the point. 

c) A cusp is a point where the line changes from straight to curve, or curve to 
straight.  To create a cusp, hold down the Control key on the keyboard. 

d) Use the Backspace key to remove any points that you want to redo. 

e) Right Click to finish the shape. 

5. 3 Point Arc   A Bezier point will be placed by each left click  

c) Each time you left click to place three points, the points will create an arc.   

d) After the first arc, the last point of each arc will also serve as the first point of 
the next arc. 

e) Right Click to finish the shape. 

6. Close Shape   
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c) Left click on Close Shape  to place the last point in the perimeter of your 
shape, and the last point will be placed exactly on top of the first point 

 

X. Backdrop Tool 
A. Bring in and edit a backdrop image that can be traced 

1. Bring in a backdrop image 

a) Left click on the Backdrop tool  

b) A browser box opens to allow you to find the picture you want to use in your 
computer files 

(1) Use clipart, digital photos, images you created in a computer drawing 
program, or images you have scanned and saved. 

c) Select the picture you want to use ( I am using a clipart picture of a sailboat) 

C. Edit your backdrop picture 

1. Select the Properties tab on the right side of the page 

a) You will be viewing the Properties of the backdrop 

2. There are three different ways that the image can be re-sized  

a) Click and drag on the handles at the corners of the selection box around the 
image on the design page 

b) Type a new width or height in the Properties box and click Apply. 

(1) Note that you will only need to change one measurement. 

(2) The other one will automatically change to keep the correct proportions 
on your image 

c) Change the Scale of your image 

(1) For instance if you want the image to be half the size it is currently, 
change the Scale to 50% and click Apply 

(2) If you want the image to be twice as big as it is currently, change the 
scale to 200% and click Apply 

3. The image can also be rotated three different ways 

a) There are buttons in the Properties page that will rotate the image 90°  or 

180°  with a single click. (No need to click Apply for this one) 

b) Just to the left of those buttons is a window for rotation.  

(1) Click and drag to highlight the number in the window and type the 
number of degrees you would like to turn the image 

(2) Click Apply and the image turns 

c) At the upper right corner and lower left corner of the selection box around the 
image you will find blue dots.   

(1) The blue dots are rotation handles 

(2) Click and drag a blue dot to rotate the image 

4. Unlimited Undo  

a) If you have made changes and you want to back up, the Undo function in Art 
and Stitch is unlimited. 

(1) You can click on Undo  as many times you want and each time 
one change that you made is undone. 
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(2) Or you can click on the little black arrowhead to the right of the Undo 
icon and see a list of the changes you have 
made. 

(a) Scroll down the list and select a 
group of changes to be undone in 
one step. 

b) You also have unlimited Redo  

(1) As soon as you use Undo, then Redo 
becomes available 

(2) Click on Redo  to move forward one change 

(3) Or click on the little black arrowhead to open the list of Undo changes 
and select how many steps forward you would like to go. 

 

XI. Plan the Path 

A. Plan how you want to trace the design 

1. Take a moment to think about how you want to sew this design and what is the best 
path to follow when tracing the image 

a) Your stitches will sew in the same order that you trace 

B. Depending on how involved your artwork is, you could spend more time planning the stitching 
path than you do tracing it. 

1. If necessary, print your image on paper 

a) Trace the path with your finger or a pencil eraser 

2. You may even want to mark your paper image with arrows and numbers so you know 
exactly what order you plan to stitch the pattern 

C. The plan for the sailboat 

1. I want to be able to sew this sailboat as a pantograph design in the border of my quilt 

a) So I will bring a line in from the left to the bottom of the boat to connect the 
boat to the previous boat in the pantograph. 

b) Then I will trace around the silhouette of the boat 

c) When I get to the lower left corner where I started around the boat, I will go 
back across the bottom of the boat 

d) And I will take a line out from the bottom of the boat to the right at the end of 
my pattern to connect the boat to the next boat. 

D. Anytime you are creating pantograph quilting patterns that can be sewn in rows across the 

quilt, you will need begin at the left side and end on the right 

 

XII. Trace the Backdrop Image and Apply Stitches 

A. Left click on the Line Tool 

1. Left click at each corner of the boat. 

2. Right click to end the pattern 

B. Remember that the backdrop picture will not be on your quilt, so if you want to trace it with 
slightly different lines, go for it. 

C. To see what you have created: 
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1. Left click on Show or Hide Backdrop  on the top tool bar to turn off the backdrop 
image. 

a) What you are seeing is the tracing you made. 

D. If you want to adjust any of your lines 

1. Left click on Reshape  

2. Left click on the line you drew 

a) The tracing turns pink and displays the 
Bezier points.  

b) Move the points if necessary to make the 
image look just the way you want it to look. 

E. Put stitches on the line you drew 

1. Left click on 3D  

2. Left click on Select  

3. Left click on Running Stitch  

4. Select a color from the Color Palette at the bottom of the page 

F. Run the Sewing Simulator 

1. The design sews exactly the same path that you traced. 

G. Save the design in both the .ans editing format and the .hqf format for the Pro-Stitcher. 

 

XIII. Why Save Both .ANS and .HQF Files  

A. Left click on New  to open a new design page 

1. I want to save a separate version of my sailboat that can be used as a block design 

B. Open the File menu and select Import Stitch File 

1. Bring in the .hqf file that was just saved 

2. Left click on the Reshape Tool  and then left click on the design 

a) And the design does not turn pink and the Bezier points are not displayed 

b) To edit the design we will need to open the .ans file 

C. Left click on New  to open a new design page 

1. Open the File menu and select Open 

2. Bring in the .ans file that was just saved 

3. Left click on the Reshape Tool  and then left click on the design 

a) And the design turns pink and the Bezier points are displayed 

b) Opening the .ans file gives us the ability to re-edit the design. 

D. Change the sailboat 

1. Remove the lines on each side of the boat so it can be sewn as an individual boat 
instead of a pantograph boat. 

a) To remove the line on the left side of the boat  

(1) Move the green start point bead out of the way  

(2) Right click on the first Bezier point at the left side of the design 

(3) Select Delete Point 
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b) To remove the line on the right side of the boat 

(1) Move the red stop point bead out of the way 

(2) Right click on the last Bezier point at the right side of the design  

(3) Select Delete Point 

c) Right click on the design page and the lines disappear 

E. Save the design with a new name 

 

XIV. Can I Use Embroidery Format Quilt Designs with Pro-Stitcher?  
A. With Art and Stitch the answer is “Yes!” 

B. To convert a design from embroidery to quilting 

1. Left click on New  to open a new design page 

2. Open the File Menu 

3. Select Import Stitch File 

4. Select the embroidery file and click Open 

5. Turn on 3D  and you will be able to see that this pattern 
already has stitches 

6. Save the design 

a) Save the .ANS file 

b) Save the .HQF file 

7. And you have just converted the embroidery design to the 
quilting format for the Pro-Stitcher 

 

XV. Use Custom Shapes to Create Designs 
A. Art and Stitch has a library of artwork built in that can be used to create quilting patterns 

B. To view the artwork in the Custom Shapes Library 

1. Left click on New  to open a new design 
page 

2. Left click on Custom Shape Library  

a) Scroll down to see some of the 
beautiful custom shapes in the library 

b) Open the window at the top of the 
box to access additional folders of 
artwork 

c) Close the Custom Shapes box 

C. Create a quilting design with a custom shape 

1. Left click on New  to open a new design page 

2. Left click on Custom Shape Library  

3. Select Sawtooth Star from the Block Patterns folder 

4. Turn on 3D  

5. Left click on Running Stitch  

6. Save the design 
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XVI. Save Your Artwork to the Library 

A. You can add your own artwork to the Custom Shape Library 

1. Draw your shape 

2.  Open the Tools menu  

3. Select Save Custom Shape 

a) A Save As box opens 

b) Click on the small black arrowhead to the right of Custom Shapes to open the 
list of folders within the Library 

c) Select the folder where you want to save the shape 

d) Type a name for your artwork in the File name window 

e) Left click Save 

B. To use your custom shape 

1. Left click on Custom Shape Library  

2. Open the Folder window at the top of the box 

3. Select the folder you put the design into 

4. And your design will be shown in that folder.  

5.  Left click on it to select it and it will be placed on the design page. 

 

XVII. Draw Geometric Shapes 

A. Just above the Custom Shape Library you will see the Rectangle tool  

1. Left click on the arrow below the Rectangle icon to open the fly-out toolbar  

a) This tool has the standard shapes like squares, triangles, and circles 

2. Select the Square 

a) Left click and drag to draw a rectangle on the design page 

B. You can control the shape that is created 

1. If you click and drag down more than you drag left to right, you will create a rectangle 
that is taller than it is wide 

2. If you drag more side to side and less up and down you can create rectangles that are 
short and wide. 

3. If you hold down the Control key on your keyboard, you will get perfectly proportioned 
squared with the width and height exactly the same size. 

4. All of the shapes on this fly-out tool bar will be drawn in the same manner. 

 

XVIII.  Resize Shapes 

A. The shapes can be re-sized 

1. Select one of the rectangles 

2. Select the Properties tab at the right side of the page 

3. Select the Transform tab in the Properties tab 

B. Change the size without changing the proportions 

1. If there is a checkmark in the Maintain aspect ratio  box 

a) Change the height to 2 inches and the width automatically changes to keep the 
same proportions  
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b) Change the width to 3 inches and the height automatically changes to keep the 
proportions unchanged. 

c) Click Apply and the size of the selected rectangle is changed on the design 
page 

C. Change the width and height separately 

1. Remove the checkmark from Maintain aspect ratio  and you can 
change the width and length independently 

a) Change the width to 2 inches and the height is not changed 

b) Change the height to 2 inches and the width is not affected 

c) Click Apply and your rectangle is now a square 

D. Change the size of the shape by scaling 

1. You can resize a shape by percentages 

2. Put the checkmark back in Maintain aspect ratio  

3. Change the width to 50% and click Apply. 

a) And the square is now half as big as it was 

4. Change the height to 250% and click Apply 

a) And the square is now 2 ½ times larger than it was. 

 

XIX.  Spiral Tool 
A. There is one unique shape on the end of this tool bar that is great fun 

1. There is a spiral tool that is ideal for quilting  

B. Select the spiral  

1. The Spiral box opens 

2. Open the Type window to select from four types of 
spirals 

a) Single Spiral 

b) Double Spiral 

c) Single Swirl 

d) Double Swirl 

3. Settings for the swirl include 

a) The number of revolutions or trips around the 
swirl 

b) Expansion factor is how much will the space 
between the spiraling lines change as the pattern 
works its way out of the center 

4. Settings for the spirals include 

a) Only the number of revolutions. 

b) The lines on the spirals will be evenly spaced 

5. Select the Double Spiral 

a) Select the number of revolutions 

6. Click OK 

7. Click and drag to create your spiral 

8. Left click on 3D  
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C. Apply stitches to your spiral 

1. Left click on  and you have a spiral quilt design 
 

XX. Repeat Design Tool 
A. The Repeat Design tool can be used to create rows or blocks of repeated designs 

B. We can use our spiral design to 
experiment with the Repeat Design 
tool 

1. Select the spiral design 

2. Left click on Repeat 

Design  

3. The Repeat Design Tool 
opens 

C. Play with the controls on the on 
the left and click Apply to see a 
preview of how the spiral has been 
repeated 

1. Number across and 
Number down control the 
number of spirals used to create the design 

2. Horizontal distance and Vertical distance control the distance between the spirals 

a) Click on the arrows pointing up to increase the distance between the spirals 

b) Click on the arrows pointing down to decrease 
the space between spirals.   

c) You can even overlap the patterns 

3. When you are pleased with the arrangement click OK 
and your repeated designs are placed on the design page. 

 

XXI. Magic Circle Tool  
A. Select and size a small shape to be used for the wreath 

1. Left click on New  to open a new design page 

2. Open the Custom Shapes Library  

3. Open the Folder window and select 
Shapes 

4. Scroll down and select Star3 

5. The shape can be re-sized to suit your 
needs 

a) If you go to Properties and 
select the Transform tab you can 
type in the size you want. 

b) Set the size of the star to 1.5 
inches. 

c) Click Apply 

B. Open the Magic Circle tool 
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1. Left click Magic Circle  and the Magic Circle tool opens 

C. Play with the controls on the on the left and click Apply to see a preview of how the spiral has 
been repeated 

1. Width and Height control the size of the circle 

a) The size of the circle is shown as Output size in the lower right corner of the 
box 

b) For an oval remove the checkmark from the Keep Aspect Ratio box.  You will 
then be able to set the Height and Width at different sizes. 

2. Count controls the number of stars in the circle 

3. Angle rotates the individual designs 

4. Rotate circle turns the circle 

5. Scale changes the size of the individual designs 

6. Rotate objects rotate the individual designs 

7. A checkmark in the Auto Rotate box rotates the designs automatically to create a 
pleasing look 

8. Mirror will flip the circle of designs left to right 

D. When you are pleased with the arrangement click OK and your circle 
of designs is placed on the design page 

E. Apply the stitches and edit for the smoothest stitching 

1. Left click on 3D  

2. Left click on Running Stitch  

3. Right click and select Merge 

F. Save the design 

 

XXII. Create a 17 Inch On Point Quilt Design 
A. Use Art and Stitch to create and edit a design that is larger than the reach of the Crown Jewel 
and the Pro-Stitcher system will be able to quilt it for you! 

1. Left click on New  to open a new design page 

B. Bring in artwork for the design from the Custom Shapes Library 

1. Open the Custom Shapes Library  

2. Select the Floral Block design in the Block Patterns folder 

a) Although this appeared to be just one corner of the design, the complete 
design with all four corners is placed on the design page. 

C. Rotate and size the artwork 

1. Select the Transform tab in Properties at the right side of the page 

2. Click and drag to highlight the 0 in the Rotate box  

3. Type 45 in the box 

4. Click Apply 

5. Double click on the Magnifying Glass  to zoom to fit, so you can see the whole 
design. 

D. Select the Transform  tab in Properties again 

1. Change the width to 17 (The size was determined by measuring the block on my quilt) 

2. Click Apply 
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3. Double click on the Magnifying Glass  to zoom to fit, so you can see the whole 
design. 

a) At 17 inches in height, this design is larger than the 14 inch area that can be 
sewn with the Crown Jewel without rolling the quilt forward. 

b) But with the Pro-Stitcher system we will be able to roll the quilt at the halfway 
point in this design. 

E. Place the stitches on the artwork  

1. Left click on 3D  

F. Edit the Start and Stop points 

1. Ideally this design needs to sew the top of the pattern from the point on the left to the 
point on the right first.   

2. Then we can roll the quilt forward and sew the bottom of the design. 

3. Left click on Reshape  

a) The design turns pink and the blue Bezier points are shown 

b) There is also a green bead for the start point of the design and a red bead for 
the end point of the design. 

(1) If you cannot see the green bead, it will be hidden under the red bead. 

(2) Click and drag on the red bead and you will always be given the green 
one first 

4. Left click and drag the green bead to the tip of the point on the left side of the design 

5. Left click and drag the red bead to the tip of the point on the left side of the design 

6. Right click on the design page to apply the change 

G. Check that the design is now going to sew in the order that we need 

1. Left click on Select  

2. Run the Sewing Simulator to see how the design will 
sew 

H. Save the design 

1. When you save the .hqf you will see a warning box to 
tell you that the design is larger than the current hoop 

2. We planned for it to be this large and with the help of 
the Pro-Stitcher, we will be able to stitch this, so click OK 
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XXIII. Quilt a Design That is Too Big with Pro-Stitcher 
A. Open your new design 

1. Touch Design  to open the Design menu 

2. Touch File  

3. Touch Open  

4. Select the D drive 
a) The D drive is the flash drive with the design we 
saved from Art and Stitch 

5. Touch the design to select it and it turns blue  

6. Touch Open  
7. And the design is place on the workspace 

B. Reposition the design so it sews in the right place on the quilt 
top 

1. Touch Reposition  in the Design menu at the left side of the page 
2. The design was positioned by using Center 

a) Measure and mark the center of the block with a chalk X 
b) Move the Crown Jewel so the needle is at the center of your chalk X 

c) Touch Center  
d) And the design moves to the new position on the quilt top 

C. Confirm that the design is positioned correctly by checking the left corner, top corner, and 
right corner 

1. Turn on Follow  
2. Move the Crown Jewel so the crosshairs on the computer screen are at the tip of the 
leaf on the left side of the pattern 

a) Look down at the fabric to see where the needle will be at that point in the 
pattern 

3. Move the Crown Jewel so the crosshairs on the computer screen are at the tip of the 
leaf at the top of the pattern 

a) Look down at the fabric to see where the needle will be at that point in the 
pattern 

4. Move the Crown Jewel so the crosshairs on the computer screen are at the tip of the 
leaf on the right side of the pattern 

a) Look down at the fabric to see where the needle will be at that point in the 
pattern 

D. And we are ready to quilt 

1. Touch Quilt  
2. Check your stitching settings at the bottom of the screen 
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a) The sample was stitched with both the beginning and ending tie offs turned on 
b) Pull Up was on for the bobbin pull, but Auto Pull Up was off 
c) Stitch was on so the pattern would be stitched rather than just traced. 

3. Touch Run 
4. The Verify Settings screen is displayed 

a) Check over your settings and make any changes needed 
b) All settings can be changed either with the icons at the bottom of the page as 

shown above, or in the Settings  menu on the left side of 
the page. 

5. Touch Proceed  
6. The Crown Jewel moves to the start point of the design and stops for the bobbin pull 
up. 

a)  Pull up the bobbin thread 

b) Touch Resume  
7. The Crown Jewel stitches the tie off very slowly and then speeds up to stitch the 
pattern 
8. When 2 inches of stitching has been sewn, the Crown Jewel pauses because the 
Pause Delay was set for 2 inches. 

a) Trim the thread tails 

b) Touch Resume  
9. And the Crown Jewel continues stitching the pattern 

E. When the top half of the pattern is complete and the machine begins to sew the bottom half of 
the pattern: 

1. Touch Pause  to stop the stitching 
2. Set the needle down into the fabric 

a) You can use the Needle 
Up/Down button on your left 
handlebar on the Crown Jewel 

b) Or you can use Half Stitch  
on the Pro-Stitcher screen 

3. Touch Disable Motors  
4. Roll the quilt forward 

a) Work carefully, moving the 
Crown Jewel along with the quilt so that needle that is in the fabric does not tear 
the quilt. 
b) Secure the rails and make sure the quilt is smooth around the needle in its new 
position 
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F. We need to move the quilt pattern to match the new position of the needle 

1. The needle is now near the take up rail of the quilt frame 
a) The red crosshairs on the computer screen cross at the spot where the needle 
is located 

2. The part of the pattern that needs to be stitched is not even close to the location 
where the needle is 

G. Touch Reposition  in the Quilt menu at the left side of the screen 

1. Touch Current Point  at the bottom of the screen 
2. And the pattern moves to match the position of the needle! 



Pro-Stitcher – Art and Stitch Basics    

                                                                                       
© 2011 Tacony Corp, all rights reserved  

 
  

19 

 
 

Suggested Companion Products for this Sew at Home Class: 

The following Amazing Design Collections have 
quilting 

 

Patterns that can be saved as .hqf patterns and 
stitched 

 

With Pro-Stitcher  
Amazing Designs Quilt Patterns I ADC-40J 
Amazing Designs Quilt Patterns II ADC-52J 
Amazing Designs Quilt Patterns III ADC-

117J 
Amazing Designs Quilt Patterns IV ADBL-16 
Amazing Designs Creative Quilting Outlines Classic 
Xmas 

CQOC 

 
 


